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1

 

elcome to the Adobe Premiere

 



 

 program—software that brings the world of 
digital movie making to the desktop. Adobe Premiere works with the Apple

 



 

 
QuickTime

 



 

 extension and lets you record, create, and play movies using video, 
sound, animations, photographs, drawings, text, and other material on your Macintosh

 



 

 
or Power Macintosh

 



 

 computer. 

Apple QuickTime is a system software extension that allows you to integrate audio and 
video into Macintosh applications. You can play Adobe Premiere movies in any applica-
tion that supports the Apple QuickTime format, or you can output movies to videotape 
or to an Edit Decision List (EDL). 

 

ABOUT THIS GUIDE

 

Before you begin using Adobe Premiere, be sure to read this guide for installation instruc-
tions and other important information. This guide contains the following:

 

•

 

Instructions for installing the Adobe Premiere software

 

•

 

A description of new features in Adobe Premiere 4.2, including detailed instructions on 
using the CD-ROM Movie Maker feature

 

•

 

Tips on improving performance in Adobe Premiere

 

•

 

Information about the Adobe Type Manager

 



 

 (ATM

 



 

) utility

 

Adobe Premiere 4.2 Getting Started

 

 is for first-time Adobe Premiere users, as well as for 
users upgrading to this version of Adobe Premiere from an earlier version of the program. 
You can upgrade from disks, or you can upgrade using the Adobe Premiere Deluxe 
CD-ROM.

 

SYSTEM REQUIREMENTS

 

To use the Adobe Premiere program, you need the following hardware and software:

 

•

 

A QuickTime-compatible Macintosh computer with a 68020 processor (Macintosh II or 
later model) and a minimum of 4 megabytes (MB) of application random-access memory 
(RAM), or a Power Macintosh computer with a minimum of 6 MB of application RAM. 

 

•

 

QuickTime (version 2.0 or later). The QuickTime extension version 2.1 is included on 
the program disks and on the Deluxe CD-ROM. Adobe Systems recommends using this 
version of QuickTime; it does not require the Multimedia Tuner. If you are using version 
2.0 of QuickTime, you also need to use the Multimedia Tuner extension.

 

•

 

Apple system software version 7 or higher
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4.2
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In addition, Adobe Systems recommends the following hardware:

 

•

 

A Macintosh computer with a 68040 processor or a Power Macintosh

 

•

 

16 MB or more application RAM for full-screen editing

 

•

 

A video digitizing board that produces movies in QuickTime format

 

•

 

A color monitor with a 24-bit video display card

 

•

 

A CD-ROM drive to use the software included on the Adobe Premiere Deluxe CD-ROM

Adobe Premiere performance improves with faster versions of the Macintosh (for exam-
ple, a Macintosh Quadra

 



 

 or Power Macintosh), more random-access memory, and faster 
and larger hard disk drives.

 

THE ADOBE PREMIERE PACKAGE CONTENTS

 

The Adobe Premiere package includes the following software and documentation:

 

•

 

The software disks

 

 

 

containing the installer software program, the Adobe Premiere 
program, the Apple QuickTime software, sample Type 1 fonts, and a number of sample 
files including motion paths and libraries

 

•

 

The Adobe Premiere Deluxe CD-ROM (For a description of its contents, see the 
following section, “Additional Contents of the Adobe Premiere Deluxe CD-ROM.”)

 

•

 

The Adobe Type Manager Install disk

 

•

 

Adobe Premiere Getting Started

 

•

 

Adobe Premiere User Guide

 

•

 

Adobe Premiere Quick Reference Card

 

•

 

Registration card

 

ADDITIONAL CONTENTS OF THE ADOBE PREMIERE DELUXE CD-ROM

 

The Adobe Premiere Deluxe CD-ROM contains everything included on the software disks 
plus the following additional software:

 

•

 

Tutorial features.

 

 The features include interactive, animated tutorials on special tech-
niques and features of Adobe Premiere. 

 

•

 

Third-party software.

 

 Additional software is included, such as filters, special effects, 
compressors/decompressors, and device control modules.

 

•

 

Stock clips.

 

 These include professional images from Archive Films, ColorBytes

 



 

, Media-
Pedia, PhotoDisc

 



 

, the WPA Film Library, and other archives licensed for your use.
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•

 

Sixth Sense

 

. This is a video art piece by John Sanborn included on Disc 1, with tutorials 
that show how the movie was put together. 

 

•

 

Online documentation.

 

 This includes the 

 

Adobe Premiere User Guid

 

e, which can be read 
on-screen using Adobe Acrobat

 



 

 software. 

 

•

 

Adobe Acrobat Reader software.

 

 This software is included so that you can view the online 
documentation and third-party reference material that have been saved as PDF (Portable 
Document Format) files. 

 

•

 

Specular Logo Motion software.

 

 This software enables you to create three-dimensional 
QuickTime animations of text and logos. A full copy of this program, along with online 
documentation, is included on Disc 1.

 

•

 

Adobe Type Library.

 

 A number of Type 1 fonts are included for your use.

 

•

 

Tryout versions of other Adobe Systems applications.

 

 These programs include Adobe 
Illustrator

 



 

, Adobe Photoshop

 



 

, and Adobe Dimensions

 



 

.

 

To explore the contents of the Adobe Premiere Deluxe CD-ROM:

 

1

 

Insert the Adobe Premiere Deluxe CD-ROM Disc 1 into your CD-ROM drive.

 

2

 

Double-click the Adobe Premiere Deluxe icon to start the program.

 

3

 

Follow the on-screen instructions. 

 

REGISTRATION

 

We are confident you will find that the Adobe Premiere program greatly increases your 
productivity. So that we can continue to provide you with the highest quality software, 
offer technical support, and keep you informed about new Adobe Premiere software 
developments, please register your copy by using the online registration software provided 
or return the enclosed warranty registration card. If you are upgrading from a previous 
version of Adobe Premiere, the original registration card with your serial number is still 
valid and you do not need to reregister the product.

 

ABOUT ADOBE PRODUCTS AND SERVICES

 

For more information about Adobe products and services, you can use forums on 
CompuServe

 



 

 and America Online

 



 

, the Adobe Home Page on the World-Wide Web 
(http://www.adobe.com), or Adobe’s own technical support bulletin-board system at 
206-623-6984. Forums and availability may vary by country.
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INSTALLING ADOBE PREMIERE

 

Use the following procedure to install the Adobe Premiere program files either from 
floppy disks or from the Deluxe CD-ROM disc. Note that you cannot run Adobe Premiere 
from the Deluxe CD-ROM; you must install the program files onto your hard disk.

The installation disks and the Deluxe CD-ROM include three versions of the Adobe Pre-
miere program: one for the 68000 series of the Macintosh, one for the Power Macintosh, 
and a universal version that runs on both types of Macintosh. The Easy Install option 
installs the 68000 or Power Macintosh version, depending on the type of computer you 
have. You can use the Custom Install option to install the universal version of the program. 
The universal version is useful if you plan to transport the application between dissimilar 
types of systems.

If you are upgrading from Adobe Premiere 4.0.1 or earlier, the Installer creates a new 
folder containing the Adobe Premiere 4.2 files. Your current Adobe Premiere files are not 
affected. 

 

Note:

 

 If you have a CD-ROM drive, you can install individual plug-in modules by dragging 
them from the Plug-ins folder on the Deluxe CD-ROM Disc 1 into your Adobe Premiere Plug-
ins folder. You cannot install individual plug-in modules from the software disks.

 

To install Adobe Premiere:

 

1

 

Choose one of two options:

 

•

 

If you are installing the program from the disks, insert the Installer disk.

 

•

 

If you are installing the program from the Deluxe CD-ROM, insert the Adobe Premiere 
Deluxe CD-ROM Disc 1 into your CD-ROM drive.

 

2

 

Double-click the Install Adobe Premiere icon to install the program files onto your hard 
disk.

 

3

 

Click Continue.

 

4

 

From the Install Adobe Premiere dialog box, choose how you want to install the Adobe 
Premiere program:

 

•

 

To install everything from all the disks onto your hard disk drive, choose Easy Install 
from the pop-up menu. This option selects the appropriate version of the program (68K 
or Power Macintosh) and installs system support files, such as QuickTime, Sound 
Manager

 



 

, and the latest version of ATM.

 

•

 

To select individual items for installation, choose Custom Install from the pop-up menu 
and select the items you want to install.
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•

 

To specify where to install the program, choose a drive from the Install Location pop-
up menu. To specify a folder, choose Select Folder from the pop-up menu and use the 
standard dialog box to select a location.

 

5

 

Click Install and follow the on-screen instructions. When installation is complete, a 
message appears, indicating that installation was successful. When you exit the installer, a 
message appears prompting you register the application online.

 

6

 

To register the application online, click Continue and then follow the on-screen 
instructions.

 

7

 

Restart your computer.

 

STARTING ADOBE PREMIERE

 

After installing Adobe Premiere, you are ready to start the program and begin exploring 
its features.

 

To start Adobe Premiere:

 

1

 

Open the Adobe Premiere folder and double-click the Adobe Premiere program icon. A 
dialog box appears, asking you to personalize your copy of the program.

 

2

 

Type your name and the name of your organization. The organization name is optional.

 

3

 

Type the serial number of your Adobe Premiere program. The serial number is located 
on the registration card, and on the first page of the 

 

Adobe Premiere User Guide

 

. 

If you are upgrading to Adobe Premiere 4.2, the serial number is also located on the first 
page of your original user guide. 

 

4

 

Click OK.

The Adobe Premiere splash screen appears. You are ready to open or create a project and 
start working.
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What’s New in Adobe Premiere 

 

4.2

 

dobe Premiere 4.2 includes new features for creating QuickTime movies that are 
optimized for CD-ROM playback. This version of Adobe Premiere also includes 
performance enhancements that improve the program’s editing capabilities.

 

CD-ROM MOVIE MAKER

 

Now make your final movies for CD-ROM playback using Adobe Premiere. The CD-ROM 
Movie Maker gives you control over standard movie output options—such as frame rate, 
size, number of colors, and audio quality—and provides additional options for optimiz-
ing CD-ROM playback. These additional options include a data rate limiter, the ability to 
set the frequency of key frames, noise reduction that can help achieve higher compression 
ratios, a PC gamma-correction filter, and a 256-color palette optimizer. You can also crop 
the entire movie and preview the crop settings, the gamma settings, the noise reduction 
settings, and deinterlacing settings before taking the time to compile the movie. Once you 
have your compression settings, you can use them to batch process movies unattended. To 
see a graphical representation of a movie’s data rate over time, use the new Data Rate Ana-
lyzer feature. For details on using the CD-ROM Movie Maker and the Data Rate Analyzer, 
see “Compiling a CD-ROM Movie” on page 15.

 

CONSTRUCTION WINDOW ENHANCEMENTS

 

The following tools and enhancements have been added to the Construction window:

 

Rate stretch tool 

 

(w from the keyboard)

 

.

 

 Use this tool to drag either end of a clip to 
change its forward

 

 

 

speed, thereby

 

 

 

changing its duration. This tool is the graphic 
equivalent of using the Speed command. The clip’s new speed and duration are reflected 
in the Project and Info windows. For more information on changing a clip’s speed, see 
“Setting the Forward or Backward Speed of Clips” in Chapter 3 of the 

 

Adobe Premiere User 
Guide

 

. 

 

Audio dissolve tool 

 

(v from the keyboard)

 

.

 

 Use this tool to create an automatic audio 
cross-dissolve between

 

 

 

two overlapping

 

 

 

audio clips by clicking the clips. In an audio 
cross-dissolve, one clip fades out as the other fades in.

 

•

 

The time ruler can now start on a timecode number other than zero. To set a new zero 
point, use the Zero Point option in the Construction Window Options dialog box.

 

•

 

Adobe Premiere now generates a QuickTime timecode track. If you have hardware that 
can read this track, you can export Linear Timecode (LTC) or Vertical Interleave Timecode 
(VITC) when you print to video. Exporting timecode is useful if you need to tape a movie 
that starts at a timecode number other than zero. 

 

•

 

You can split all the unlocked tracks in the Construction window at once by using the 
new Razor at Edit Line command on the Edit menu.

 

A
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SHORTCUTS

 

•

 

Now mark in and out points with function keys. New Mark In and Mark Out 
commands have been added to the Clip menu. By adding these commands to the 
Commands palette, you can assign them to function keys. For more information on using 
the Commands palette, see “Using the Commands Palette” in Chapter 2 of the 

 

Adobe 
Premiere User Guide

 

.

 

•

 

Hold down the Command, Control, and Option keys while clicking a clip in either 
the Construction or Project windows to open a pop-up menu containing Clip and Edit 
menu commands. The commands available depend on the type of clip you selected and 
its location. 

 

•

 

To insert multiple transitions of the same type, add the first transition using the Transi-
tion window; then hold down the Option key and, using the selection tool, click the T 
track between two overlapping clips in the A and B tracks. The duration and direction of 
the transition are automatically set just as they are when you drag a transition into place 
from the Transitions window. If a transition has not been previously added, Option-
clicking the T track adds a Cross Dissolve.

 

•

 

You now can press Command-period on your keyboard to stop video capture.

 

•

 

When the Construction window is active, pressing the spacebar toggles the Controller 
between play and stop. For more information on using the Controller to preview movies, 
see “Using the Controller” in Chapter 4 of the 

 

Adobe Premiere User Guide

 

.

 

•

 

Double-click in the Project window to open the Import dialog box. Triple-click, or 
Command+double-click, in the Project window to open the Import Multiple dialog box.

 

•

 

Adobe Premiere windows now snap to other windows, to the bottom of the menu bar, 
and to the edges of the screen to make it easier to organize the Adobe Premiere desktop.

 

TRANSITIONS WINDOW OPTIONS

 

You can organize the Transitions window with the new Transitions Window Options com-
mand. You can remove transitions you don’t use, create different sets of transitions for dif-
ferent projects, and reduce the size of the transition icons in the Transitions window.

 

To organize the Transitions window:

 

1

 

Activate the Transitions window and choose Windows > Transitions Window Options.

 

2

 

Set options as follows:

 

•

 

To remove a transition you don’t use, select it from the Current list and click Remove. 
Shift+click to select multiple adjacent transitions; Command+click to select nonadjacent 
transitions. 
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•

 

If you only use a few transitions, click Remove All, then select the transitions you want 
from the Available list and click Add. 

 

•

 

To add a transition to the current set, select it from the Available list and click Add. You 
can also drag transitions from one list and drop them in the other list.

 

•

 

Click Save to save the current set of transitions.

 

•

 

Click Load to open a saved set of transitions.

 

•

 

Click Show Descriptions to display the transition descriptions in the Transitions 
window. This also increases the size of the transition thumbnail.

 

NEW AUDIO FILTERS

 

There are three new audio filters: Downsample, Swap Left and Right, and Pan.

 

•

 

The Downsample filter enhances conversion from one audio sample rate to a lower 
sample rate by applying a low pass filter to the audio clip. Three quality options (Good, 
Better, and Best) provide increasing degrees of audio quality at the expense of longer 
processing time. (You convert audio in Adobe Premiere when your compiled movie’s 
audio sampling rate is lower than your source clip’s sampling rate, or when exporting an 
audio clip to an AIFF file.)

 

Note:

 

 The Downsample filter is applied directly to the clip’s source file. This provides the best 
quality filtering but cancels the effect of any filters applied before the Downsample filter. 
Therefore, the Downsample filter should always be the first filter applied to a clip. 

 

•

 

The Swap Left and Right filter transposes the left and right channels of a clip. This is 
useful if you accidentally recorded the channels in reverse and need to correct it to produce 
the movie.

 

•

 

The Pan audio filter pans audio from left to right, much like the balance control on an 
amplifier. Use the slider to pan the clip left or right. Press the spacebar to center the slider. 
Click the Preview Sound option to listen to the effect of the filter as you make adjustments 
with the slider. (To hear the effect of the Pan filter during preview, make sure you set the 
preview options to stereo.)
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The Pan filter can be also applied over time by using the Start and End buttons in the Fil-
ters dialog box. For more information on varying a filter over time, see “Changing Adobe 
Photoshop Filters over Time” in Chapter 6 of the 

 

Adobe Premiere User Guide.

 

 

 

NEW MOTION OPTIONS

 

The Smoothing option in the Motion dialog box now includes a pop-up menu that lets 
you select the amount of smoothing to apply. The Smoothing option affects how a clip 
changes direction. If Smoothing is not selected, a clip will move sharply from point to 
point. With Smoothing selected, a clip will appear to curve around corners. The amount 
of smoothing controls the softness of the curve.

The Smoothing pop-up menu offers five degrees of smoothing: Smooth Motion, Smooth 
More, Averaging (low), Averaging (medium), and Averaging (high). The first two options 
use a fixed number of points when calculating the smoothing. The last three options use 
an average of the entire motion path to calculate the smoothing. 

The Show Path option displays a series of dots along the motion path instead of a solid 
line. Each of the dots represents a frame from the clip. The dots show approximate frame 
locations, smoothing effects, and the applied acceleration (represented by the spacing 
between the dots). For clips that have many frames, the number of dots is an approximation.

 

OFFLINE FILES

 

Now you can open a project and skip files that are unavailable without removing them 
from the project. Adobe Premiere inserts a placeholder for each clip you designate as 
offline. This feature lets you work on a project that contains missing clips. In the past, 
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missing clips would have been permanently removed from the project. Adobe Premiere 
maintains the timecode and reel name for offline files so that you can still export Edit 
Decision Lists (EDL). If a missing clip has been deleted from a hard disk, you can recapture 
the footage by dragging the offline placeholder into a batch window for capture.

When you open a project, Adobe Premiere notifies you if any files are missing. You can use 
the dialog box that appears to locate the files, skip them entirely, or specify them as offline. 
Click the Offline button to replace the specified file with a placeholder, or choose All 
Offline to replace all missing files with placeholders.

 

Note:

 

 The Offline and All Offline options appear only for projects that have been saved with 
Adobe Premiere 4.0.1. These options do not appear for projects saved with Adobe Premiere 4.0 
or earlier.

 

Once a placeholder has been added to a project, you can exchange it with the actual clip at 
any time by double-clicking the placeholder in either the Construction or Project window. 
Click the Locate button in the dialog box that appears and use the Open dialog box to 
select the file. 

You can also create a new offline file placeholder for future material, or material you want 
to add to the project that is located on a volume that is not currently mounted or remains 
to be captured.
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To create offline file placeholders for future material:

 

1

 

Choose File > New > Offline File. The New Offline File dialog box appears.

 

2

 

Enter the filename and duration for the clip. 

 

3

 

If the file represents a clip from a videotape, you can also provide the starting timecode, 
the timecode format, and a reel name.

 

4

 

Use the Has Video and Has Audio options to include video and audio tracks in the 
placeholders.

 

ENHANCED AND SIMPLIFIED OUTPUT OPTIONS

 

The Output Options dialog box contains the following changes:

 

•

 

The new Flatten option lets you create a movie that can be played back on both Macin-
tosh and Windows

 



 

 computers. The Flatten option eliminates the need to separately 
export flattened movies after they have been compiled. For more information on creating 
cross-platform movies, see “About Creating Cross-Platform Movies” on page 14.

 

•

 

The new Optimize Stills option can help solve playback problems with some hardware-
based playback systems. In the past, Adobe Premiere optimized still images by default—
for example, if a still image in a 15-frames-per-second (fps) movie had a duration of 2 
seconds, it would create a single frame that was 2 seconds long, rather than create 30 indi-
vidual frames. The advantage of optimizing stills is that it creates smaller movie files. In 
general, you should make movies with this option turned on. If you make a movie that 
contains a large number of still images and you experience playback problems, try making 
it with this option turned off.

 

•

 

The 1/2 Horizontal and 1/2 Vertical options in the Types menu have been removed. 
(These options have been removed from the Types menu in the Preview Options dialog 
box as well.) 
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CAPTURE ENHANCEMENTS

 

Adobe Premiere 4.2 includes these new capture features:

 

•

 

You can lower the audio capture block size. By default, QuickTime captures audio in 
2-second blocks, also known as chunks. This block size may cause playback problems with 
video captured at high data rates (over 3 MB per second). To set the audio block size, use 
the Audio Block Size option in the Recording Settings dialog box. For more information 
on capturing audio, see “Selecting Audio Input Options” in Chapter 9 of the 

 

Adobe 
Premiere User Guide

 

.

 

•

 

The Batch Capture window is now resizeable. You can drag and drop items between 
Batch Capture windows and drag offline file placeholders into a Batch Capture window. 
For more information on offline file placeholders, see “Offline Files” on page 9.

 

FRAME BLENDING FOR SLOW-MOTION CLIPS

 

Now when you lower the speed of a clip you can blend frames together for a smoother 
slow-motion effect. When you slow a clip, or extend its duration, Adobe Premiere adds 
duplicate frames. You can blend these frames together by using the new Frame Blending 
option in the Frame Hold dialog box. You can also specify an alternate rate for the clip in 
the Frame Hold dialog box to create a slow-motion special effect. 

 

FLICKER REMOVAL FOR FIELD RENDERING

 

The Flicker Removal option has been added to the Field Options dialog box. This option 
adds a vertical convolution filter to the movie so very thin 1-pixel lines will not flicker on 
interlaced monitors, such as NTSC monitors. Use this option if you create titles with 
1-pixel lines or light-weighted serif fonts and then output the movie to videotape.

 

ASPECT FILL COLOR

 

Previously, when you used the Maintain Aspect Ratio on a clip, Adobe Premiere filled the 
border around the clip in black. Now you can use the Aspect Fill Color command on the 
Clip menu to select a different color for this area.
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CD-ROM Movie Maker

 

he CD-ROM Movie Maker plug-in lets you use Adobe Premiere to optimize your 
QuickTime movies for playback off CD-ROM by uniformly limiting the data 
rate and automatically flattening movies for cross-platform delivery. In the past, 

many Adobe Premiere users have used third-party utilities such as Apple MovieShop

 



 

 to 
optimize movies for CD-ROM playback. The CD-ROM Movie Maker eliminates this extra 
step. Now you can optimize your movies with Adobe Premiere.

The CD-ROM Movie Maker enables you to do the following tasks:

 

•

 

Limit and smooth your movie’s data rate

 

•

 

Crop your movie and preview the crop settings

 

•

 

Add and preview gamma correction, noise reduction, and deinterlacing filters

 

•

 

Resize your movie using the same high-quality interpolation method used by Adobe 
After Effects

 



 

•

 

Generate a specific color palette to optimize playback on 8-bit systems or attach an 
optimized palette you’ve already created

 

•

 

Specify a key frame rate and set key frames at markers or edits

 

•

 

Build CD-ROM optimized movies in batches

 

•

 

Troubleshoot movies with a new data rate analysis feature

 

ABOUT MAKING CD-ROM MOVIES

 

Digitizing

 

 video or film is the process of converting analog images into digital data. The 
amount of data that uncompressed full-screen (640 x 480 pixels), full-motion (30 fps) 
video produces is immense. A single second of video with sound can produce over 28 
megabytes of data. However, CD-ROM drives transfer data at rates between 90 and 550 
kilobytes per second, depending on the speed of the drive. Even at the higher of these 
speeds, 28 MB of data in one second of video is 50 times more data than the drive can 
transfer.

What makes playing video possible on personal computers is data compression. The most 
efficient compression technologies manipulate video frames in such a way that redundant 
data can be discarded. Using one of these compressors, you can achieve manageable data 
levels, but often not low enough to compensate for the relatively slow speeds of CD-ROM 
drives. To further reduce the data rate, you must reduce the amount of data in the movie. 

 

T
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Two of the most effective methods for reducing data are reducing the frame rate and 
the frame size. Smaller and fewer frames result in less data having to be transferred to 
the computer. 

To further complicate matters, the quality of playback off CD-ROM is affected by how 
uniformly the movie’s data is transferred to the computer. A dramatic scene change in 
a movie can overwhelm the computer with data. These 

 

data spikes

 

 usually force the 
computer to drop some data to keep up with the movie, resulting in dropped frames 
and out-of-sync audio.

Limiting the data rate helps avoid data spikes. When they are encountered during com-
pression, Adobe Premiere employs a number of techniques, depending on the selected 
compressor, to keep the data rate down and uniform. Two common techniques are tem-
porarily lowering the frame rate or lowering the image resolution. See “Maintaining the 
Data Rate” on page 20 for information on how data spikes are managed. 

Video compression can reduce data rates, but often not to the level required for CD-ROM 
playback. To play movies from CD-ROM, you must make trade-offs between frame size, 
frame rate, color depth, and audio quality. The choices you make depend on your audi-
ence’s expectations, the content and quality of your source material, and your standards. 
Some suggested settings are provided at the end of this guide.

 

ABOUT CREATING CROSS-PLATFORM MOVIES

 

If you are creating movies for playback on both Macintosh and Windows computers, 
understanding some basic concepts can help you avoid future problems. To begin with, 
Windows computers can play only flattened QuickTime movies (also known as self-con-
tained and single-fork movies). On the Macintosh, QuickTime movies are divided into 
two parts: a data fork containing movie and sound information, and a resource fork with 
descriptions of that information. Windows doesn’t support this, therefore all of the movie 
must be stored in a single fork. This process is called 

 

flattening

 

. The Macintosh plays flat-
tened movies just as well as unflattened movies. The CD-ROM Movie Maker automati-
cally creates flattened movies.

Another issue that affects cross-platform playback is the gamma difference between Mac-
intosh and Windows computers. Because of this difference, a movie may appear darker on 
a Windows computer than on the Macintosh. You can correct for this difference by using 
the PC Gamma option in the CD-ROM Movie Options dialog box. 

You must also consider the audio sampling rate you use. The Macintosh can handle sam-
pling rates on a continuous scale, whereas Windows-compatible sound cards may have 
trouble with anything but discrete sampling rates. Windows-compatible sound cards can 
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also have problems with movies that contain multiple sampling rates. When setting the 
sampling rate for your movie’s audio, use discrete rates such as 44100 Hz, 22050 Hz, and 
11025 Hz to avoid possible cross-platform playback problems.

When selecting a CODEC (compressor/decompressor), choose one that is available on 
both platforms, such as Cinepak

 



 

 or Indeo

 



 

. If you use Indeo, you’ll have to include it on 
your CD-ROM because it’s not a native QuickTime CODEC. The Indeo CODEC is 
included on the Adobe Premiere Deluxe CD-ROM with its own Read-Me file. 

When naming the completed movies use eight characters or less and add the .mov exten-
sion, for example, premiere.mov. QuickTime for Windows requires that QuickTime 
movies have the .mov extension. The .avi extension is for Video for Windows files.

 

COMPILING A CD-ROM MOVIE

 

The CD-ROM Movie Maker compiles a movie from your work in the Construction win-
dow. The compiled QuickTime movie is a self-contained, flattened file separate from your 
project. The CD-ROM Movie Maker stores the entire movie in the data fork, making it 
automatically cross-platform-compatible so that it can be played back on both Macintosh 
and Windows computers. 

 

To compile a movie for CD-ROM:

 

1

 

Choose Make > CD-ROM Movie. 

 

2

 

Use the Output pop-up menu to specify which part of the Construction window to 
compile. Select Entire Project to compile everything in the Construction window. Select 
Work Area to compile only the segment under the yellow work area bar.

 

3

 

Choose video and audio options as described in the following sections.

 

4

 

Click More Options to select a noise reduction filter, set advanced key framing and 
data rate options, and crop the movie, or to attach or generate an optimized playback 
palette of 256 colors. 

 

5

 

Select Show Sample Frames to see each frame of your movie in the Preview window as 
it is being compressed. 

 

6

 

Click OK, type a name for the movie, and click Save.

 

Specifying frame size

 

Use the Size text boxes to set the pixel width and height of your movie frames. If the 
4:3 Aspect option is selected, entering just the height or width updates the other value 
automatically.
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If you are resizing your movie, you can optimize the results using the Special Processing 
options. For more information, see “Setting Special Processing Options” on page 22.

When setting your frame size, keep in mind that larger frame sizes result in larger files and 
higher data rates. When making movies for CD-ROM playback, you must balance size and 
the desired frame rate. In most cases, 320 x 240 is the largest frame size that you can play 
back successfully off CD-ROM.

 

Important: 

 

If you’re using the Cinepak CODEC and a frame size that’s not a QuickTime 
standard, make sure the dimensions are multiples of 4 because Cinepak is optimized to work 
with 4 x 4 pixel cells. Standard QuickTime frame sizes are 320 x 240, 240 x 180, 160 x 120, 
and 120 x 90.

 

Choosing a compressor/decompressor (CODEC)

 

CODECs are content specific, therefore, the best choice for your movie depends on the 
images in the movie. However, for content obtained from analog videotape that will be 
played back off CD-ROM, Cinepak is the most commonly used.

The Compression option lists all the QuickTime-compatible CODECs you have installed, 
including hardware-based CODECs. If you use a hardware-based CODEC for compres-
sion, your audience must have the equivalent hardware for playback.

 

•

 

Animation is the best CODEC for animation and computer-generated images that were 
not obtained from analog videotape. The Animation CODEC employs run-length 
encoding and is highly sensitive to image changes. Because Animation is a lossless 
compressor, it’s a good CODEC to use if you need to compile a movie to work with 
it in another application, such as Adobe After Effects.

 

•

 

Cinepak is the best CODEC, in most cases, for delivering video on CD-ROM. It’s opti-
mized for compressing 16-bit and 24-bit video and attains higher compression ratios, 
better image quality, and faster playback speeds than the Video CODEC. For best results, 
use the Cinepak CODEC on raw source clips that have not been previously compressed 
with a high lossy compressor. Cinepak is highly asymmetrical, meaning decompression is 
much faster than compression.

 

•

 

Video is an adequate CODEC for CD-ROM playback. It provides relatively fast 
compression with fairly high image quality, but only moderate quality playback from 
CD-ROM. Cinepak provides faster decompression. However, movies compressed using 
the Video CODEC can be recompressed with minimal or no quality degradation.
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•

 

Component Video is not a suitable CODEC for CD-ROM playback. It’s perfectly 
symmetrical, requiring the same amount of time to compress as to decompress, and only 
provides a 2:1 compression ratio. It’s best suited for archival or interim storage because it 
maintains a high degree of image quality.

 

•

 

Graphics is not a suitable CODEC for CD-ROM playback. While it can provide better 
playback results on 8-bit systems than the Video CODEC, it does not achieve high 
compression ratios for video. 

 

•

 

None is not a suitable option for CD-ROM playback because no compression is applied. 

 

•

 

PhotoJPEG is not a suitable CODEC for CD-ROM playback because it requires too 
much time for decompression. It’s best suited for still images, like photographs, because it 
compresses natural images at a high ratio with excellent image quality. 

 

Setting color depth

 

As a general rule, choose the smaller of the color depth of your source clips or the color 
depth of your target playback system. For example, if your clip is a computer-generated 
animation in 16 colors (4-bit), a deeper color setting will not result in more colors. Like-
wise, if your target playback system is 8-bit (256 colors), selecting a bit depth higher than 
8 bits will result in a larger file without any improvement in the playback quality. 

 

Using an optimized palette

 

If your target playback systems are 8-bit and your movie is deeper than 8-bit, you can 
have Adobe Premiere generate an optimized palette or you can attach a palette you’ve gen-
erated with another application, such as Adobe Photoshop or Equilibrium Technologies 
DeBabelizer. You can also attach a palette from a movie that already has one. An optimized 
palette contains 256 colors based on the contents of the CD-ROM movie. Movie Maker 
embeds the palette in the movie as a color lookup table (CLUT) resource. 

When the movie is played back on an 8-bit system, it will use this optimized palette. Oth-
erwise it will use the system palette. Using an optimized palette on 8-bit systems usually 
provides better results than relying on the system palette.

 

To generate an optimized palette:

 

Select Playback Palette in the CD-ROM Movie Options dialog box and select Calculate 
New.

 

To attach a specific palette:

 

1

 

Select Playback Palette and Load from File in the CD-ROM Movie Options dialog box. 
A standard File Open dialog box appears.

 

2

 

Select the desired file and click OK. 
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Setting a frame rate

 

Select a rate in the range of 10 to 15 (fps) for the best results on the broadest range of play-
back systems. When choosing a frame rate, keep in mind the following:

 

•

 

In most cases, at rates below 15 fps, the illusion of continuous motion begins to break 
down and the distinct images that make up the movie begin to be perceptible. However, a 
suitable frame rate depends on the content of your movie. For example, a slow moving 
scene such as a sunset won’t suffer from a slower frame rate, whereas a movie that contains 
fast action or close-ups of people speaking will.

 

•

 

When reducing the frame rate, try to use even multiples of your source format. For 
example, for 30 fps video, use frame rates of 5, 6, 10, and 15 fps. Using uneven multiples 
can result in movies with uneven motion. 

 

•

 

It’s only effective to reduce the frame rate of your source clips; there is no benefit from 
increasing it. Setting a frame rate higher than your source clips simply results in duplicated 
frames. 

 

Note:

 

 In some cases, you may need to add new frames to a movie to increase its duration 
without changing its speed. For example, you want a movie to play one second longer, but you 
need it to play at its existing frame rate. In this case, you can use a program, such as Adobe 
After Effects, that interpolates new frames by averaging the content of existing frames. 

 

Selecting a key frame rate

 

Most QuickTime compressors/decompressors (CODECs) use a compression strategy 
called 

 

frame differencing

 

. At regular intervals, the CODEC keeps a complete frame of video 
intact. This frame is called a 

 

key frame

 

 and serves as a reference point for subsequent 
frames before the next key frame. The frames between key frames are called 

 

differenced 
frames

 

 or 

 

delta frames

 

 and contain only the data that is different from the previous key 
frame. 

A general guideline for video with sound is to use one key frame per second. For example, 
with a frame rate of 15 fps, set the key frame rate to 15. You can improve playback quality 
with a key frame rate of 4 or 7, but more frequent key frames can cause playback problems 
on older and slower systems. For animation, you can use a much higher rate, such as one 
key frame every 5 to 10 seconds. (If your frame rate is 15 fps, a key frame rate of 75 sets a 
key frame every 5 seconds.) 
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In movies that have motion, set a low key frame rate to avoid possible artifacting. If you 
use a low key frame rate, you reduce the possible impact of artifacting because the movie 
is being completely updated more frequently. If you create a movie with blue-screen com-
positing and you notice a subtle, but frequent pulsing in the background, try setting a high 
key frame rate. 

If you allow your audience random-access playback, such as being able to move through 
the movie frame-by-frame or by dragging a slider bar, use a low key frame rate. Random-
access playback suffers with infrequent key framing. And finally, keep in mind that because 
key frames have more data than differenced frames, more key frames generally result in 
larger files and higher data rates. 

 

Using markers or edits to specify key frames

 

Instead of selecting a regulated key frame rate, you can use markers or edits in the Con-
struction window to specify key frames. Use either option if you need to begin playback at 
a specific frame in a movie, for example, if the movie will be used in an interactive title and 
you want to play a movie starting at different frames depending on user input. You may 
also want to use either option if you use infrequent key framing and you want to improve 
random-access playback.

Generally, the two frames that surround an edit are high in image contrast and provide a 
natural point at which to create a key frame. If your movie is composed of several clips 
with very different source material, or if the movie transitions frequently, using the Add 
Key Frames at Edits option may provide better key framing than a consistent key frame 
rate. An edit is any transition point between two clips in the Construction window, 
including cuts.

 

To use markers to specify key frames:

 

1

 

In the Construction window, set markers at the desired locations.

 

2

 

Set the Key Frame Rate in the CD-ROM Movie Options dialog box to a number that 
is greater than the total number of frames in your movie. For example, if your movie is 
20 seconds long at 15 fps, set the Key Frame Rate higher than 300. This ensures that only 
the first frame and any frame with a marker will be used as key frames.

 

3

 

Select Add Key Frames at Markers in the CD-ROM Movie Options dialog box.

 

To set key frames at edits:

 

1

 

Set the Key Frame Rate in the CD-ROM Movie Options dialog box to a number that is 
greater than the total number of frames in your movie. 

 

2

 

Select Add Key Frames at Edits.
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Limiting the data rate

 

The data rate defines a maximum amount of data per second for your movie. Limiting the 
data rate with Adobe Premiere not only keeps the data rate under a predefined peak, it also 
smooths out the data rate to make it as uniform as possible.

The rate you set depends on the speed of the CD-ROM drive you are targeting as your 
playback device. For single-speed drives, typical rates are between 90–100K/second; for 
double-speed drives, typical rates are between 140–220K/second; for quad-speed drives, 
typical rates are between 450–510K/second.

 

Maintaining the data rate

 

When the CD-ROM Movie Maker encounters data spikes in a movie, it has two options: 
it can temporarily lower the frame rate, or it can temporarily increase compression by 
reducing the image resolution. Using the Maintain Data Rate By options, you can tell the 
CD-ROM Movie Maker to both lower the frame rate and increase the compression, or use 
one or the other option. By default, the CD-ROM Movie Maker increases compression.

 

Specifying the audio format, frequency, and interleave

 

When choosing audio options, keep in mind the following:

 

•

 

On the Macintosh, a sound card and the Sound Manager extension version 3.0 or later 
are required to reproduce 16-bit audio; 8-bit audio is the default on the Macintosh and 
16-bit audio is the default on the Power Macintosh. With Windows, a sound card is 
required to reproduce both 8-bit and 16-bit audio output.

 

•

 

If you are developing movies for Macintosh and Windows playback, select a discrete 
audio rate, such as 44100 Hz, 22050 Hz, or 11025 Hz. Many Windows-compatible sound 
cards cannot play back nondiscrete audio rates. 

 

•

 

Use stereo only if your source clips are stereo and your target playback system supports 
stereo.

 

•

 

Setting a higher frequency than the sampling frequency of your original clip’s audio does 
not improve quality. If you originally recorded the audio at 22050 Hz, setting the audio to 
44100 Hz only increases the file size.

 

•

 

The recommended audio interleave is 1/2 second, which is the default setting. If you 
want to set an interleave that is less than 1/2 second, select Other and enter the number of 
frames.

 

Note:

 

 If you are setting the movie’s audio rate below the audio rate of your clips, you can 
enhance this audio conversion by applying the Downsample filter to your audio clips. For 
more information on the Downsample filter, see “New Audio Filters” on page 8.
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Suggested compression settings

 

Use the following compression settings as guidelines only. 

 

Compression settings are highly 
content-specific.

 

 Experiment with a variety of settings until you get acceptable results. 

 

Single-speed CD-ROM drives

 

•

 

Size: 240 x 180

 

•

 

Compressor: Cinepak (Use Animation for animation)

 

•

 

Data rate: 100K/second maximum

 

•

 

Bit depth: 24-bit (millions of colors)

 

•

 

Frame rate: 10 fps

 

•

 

Audio format and frequency: 11025 Hz, 8-bit, mono

 

Double-speed and triple-speed CD-ROM drives

 

•

 

Size: 320 x 240

 

•

 

Compressor: Cinepak (Use Animation for animation)

 

•

 

Data rate: 90–240K/second

 

•

 

Bit depth: 24-bit (millions of colors)

 

•

 

Frame rate: 10–30 fps

 

•

 

Audio format and frequency: 22050 Hz, 8-bit, stereo with lower frame rates; 11025 Hz 
or 22050 Hz, 8-bit, mono with higher frame rates

 

Quad-speed CD-ROM drives

 

•

 

Size: 320 x 240

 

•

 

Compressor: Cinepak (Use Animation for animation)

 

•

 

Data rate: 450–510K/second

 

•

 

Bit depth: 24-bit (millions of colors)

 

•

 

Frame rate: 30 fps

 

•

 

Audio format and frequency: 22050 Hz, 16-bit, mono or stereo

 

Note:

 

 While the sustained transfer rates of quad-speed drives allow for 44100 Hz sound, a 
large percentage of computers can play back only 22050 Hz sound. Digitizing sound at a 
higher rate will degrade playback performance because the audio must be converted to the 
lower sample rate during playback.
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SETTING SPECIAL PROCESSING OPTIONS

 

The special processing options enable you to crop your movie, add a PC gamma-correc-
tion filter, add a noise reduction filter, deinterlace your movie, and optimize movie resiz-
ing. You can set these options with confidence because Adobe Premiere dynamically pre-
views these options. The preview also shows you the effect of any other filters and 
transitions. 

 

Using the Noise Reduction option

 

You can add a blur to your movie, softening the image and creating an illusion of slightly 
higher resolution at lower data rates, especially when using Cinepak. For example, if you 
compile two versions of the same movie with an aggressively low data rate, one with a blur 
and one without, the movie with the blur will appear to have a higher resolution than the 
other movie.

You have three quality options: Blur, Gaussian Blur, and Median. Blur is the most subtle 
option, smoothing significant color transitions by averaging the pixels next to the hard 
edges of defined lines and shaded areas. Gaussian Blur is stronger than the Blur option and 
can produce a hazy effect. Median blurs an image more than the other two options, but 
the Median option is designed to preserve the edges of objects. For example, if you use the 
Median option on a close-up, you’ll lose detail in the broader areas of the face, such as 
wrinkles in the cheeks and forehead, but retain detail where features create hard edges, 
such as the eyes and mouth. 

 

Setting gamma correction

 

Use the PC Gamma option if your movies will be played on both PC and Macintosh com-
puters. The PC Gamma option changes the brightness levels of the midtones (the middle-
gray levels) while leaving the black and white areas unaffected. A gamma setting of 0.7 or 
0.8 is usually adequate to compensate for cross-platform gamma differences. 

 

Optimizing resizing

 

If your movie’s frame size is smaller than your clip size, you can optimize the movie by 
using the Better Resize option. With this option selected, Adobe Premiere resizes the 
movie using the same interpolation method as found in Adobe After Effects. If you don’t 
use this option, QuickTime resizes the movie using a lower quality interpolation method.

 

Deinterlacing

 

If your clips are 640 x 480 pixels or larger and your movie’s frame size is smaller than 
640 x 480 pixels, you should use the Deinterlace option. This removes the secondary field 
in each frame and doubles the lines of the dominant field. If you don’t use this option, 
QuickTime will deinterlace the fields using a lower quality method. 
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Cropping CD-ROM movies

 

You can use the CD-ROM Movie Maker to crop unwanted pixels from the edges of your 
movie and either resize the movie or scale the image to fit the original frame size (as spec-
ified with the Size option). Crop by either entering the exact number of pixels you want to 
remove from the movie’s edges or drag the corners of the preview’s cropping box. 

The cropping feature crops the entire movie. If you want to crop just a clip in the movie, 
use the Crop or Image Pan filters, or the Zoom option with the Motion command. 

 

To crop a movie:

 

1

 

From the CD-ROM Movie Options dialog box, select Special Processing. If the Special 
Processing option is not visible, click More Options.

 

2

 

Choose one of two options:

 

•

 

Enter the number of pixels you want to crop from each edge in the respective text boxes.

 

•

 

Resize the cropping box by dragging one of the square handles at any corner. As you 
resize and move the cropping box, Adobe Premiere displays the coordinates of the upper 
left and lower right corners of the cropping box. It also displays the size of the cropping 
box.

 

Important:

 

 If you are using Cinepak, crop in multiples of 4 because Cinepak operates on 
4 x 4 pixel cells. 

 

3

 

Drag the slider bar to step through the movie and preview how your crop settings affect 
individual frames. 

 

4

 

If you want to scale the cropped image to the movie’s frame size, select Scale to Original 
Size. Keep in mind that scaling the movie can distort the image.

 

BATCH PROCESSING CD-ROM MOVIES

 

The Batch CD-ROM Movie Maker feature enables you to process multiple movies at one 
time. You can include both Adobe Premiere projects and QuickTime movie files in your 
batch list. This allows you to compress QuickTime movies in a batch without having to 
create projects for them. You can also selectively process items in a batch list.

The Batch CD-ROM Movie Maker processes all the items in the batch list with the same 
compression options. You set compression options after creating the batch list.

 

To batch process CD-ROM movies:

 

1 Select File > Tools > Batch CD-ROM Movie Maker. 
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2 Set batch processing options as desired:

• To add files to the batch list, click Add and then use the Open dialog box to specify the 
projects and QuickTime movies you want to process. The projects and QuickTime files 
you add appear in the Projects to Process list, and their corresponding compiled movie 
names appear in the Output Movie list.

• To change the name or location of a compiled movie, select the project in the list and 
click Target. Use the Save dialog box to rename or relocate the target movie.

• To make sure that all files associated with a project are still in their proper locations, 
select the project in the list and click Check. Adobe Premiere will prompt you for new file 
locations, if necessary. If you do not use this option, batch processing will be interrupted 
if files are not in their expected location.

• To compile the projects in a previously saved batch list, click Load. Use the Open dialog 
box to locate and add the batch list you want to compile. 

• To process a subset of files in the batch list, unhighlight the files you don’t want to 
process.

• To save the batch list after adding all of the files you want to compile, click Save. Use the 
Save dialog box to name and store the list.

• To conform all movies in the batch list to the same timebase, click Timebase and choose 
a timebase from the dialog box that appears. This option makes it easy to conform existing 
QuickTime movies in a batch without having to create projects for them.

3 Click Make to begin the compiling process. A dialog box appears allowing you to specify 
the movies you want to compile.

4 Choose to compile all the movies in the batch list, or only the movies you selected from 
the batch list. The CD-ROM Movie Options dialog box appears.

5 Set compression options for the batched movies and click OK.
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USING THE DATA RATE ANALYZER
Adobe Premiere’s data rate analysis feature provides a valuable troubleshooting tool. The 
Data Rate Analyzer graphs each frame of your movie to show you the key frame rate, the 
difference between key frames and differenced frames, and data rate levels. A preview win-
dow lets you move through the movie to find trouble spots. An analysis window provides 
information about the frame in the preview. 

To use the Data Rate Analyzer:

1 Choose one of the following options:

• To analyze a movie that is open in the Clip window, activate the Clip window, then hold 
down the Option key and choose File > Tools > Data Rate Analyzer.

• If a movie is not open, choose File > Tools > Data Rate Analyzer. Use the Open File 
dialog box to locate the desired movie. You can also click Find and enter the filename to 
locate the file.

2 Use the following methods to change the sampled frame. The sampled frame appears in 
the preview window.

• Use the arrow keys to move from frame to frame. To move from key frame to key frame, 
hold down the Command key as you press an arrow key.

Key frame





Differenced frames





Sampled frame

Data rate over the entire movie

Average data rate (graphical)

Average data rate (numerical)

Average key frame rate
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• Drag the slider below the preview window.

• Click in the Time bar.

• Click any frame in the data rate graph.

3 Click Analysis to open the Movie Analysis window for more information about 
the movie.

TROUBLESHOOTING CD-ROM MOVIES
This section addresses some common problems that occur when making movies for 
CD-ROM playback.

Trouble with playback on older computers

Most likely, the data rate of your movie is higher than the CD-ROM drive can sustain. 
Keep in mind that older computers usually have older peripherals. In the case of CD-ROM 
drives, this means single-speed CD-ROM drives with lower data transfer rates. Try setting 
a higher key frame rate. If playback doesn’t improve, you’ll have to lower data rate by either 
reducing the frame rate or the frame size, or both.

Hard disk playback is fine, but CD-ROM playback is poor

The data rate of your movies is higher than the CD-ROM drive can handle. Use the Data 
Rate Analyzer in Adobe Premiere to check the data rate. The data rate of the movie should 
be lower than the sustained data rate of the CD-ROM drive. 

Trouble with playback from some CD-ROM drives

If the problematic drives are triple-speed CD-ROM drives, your data rate is too high for 
these drives. Some CD-ROM manufacturers have been known to exaggerate performance 
standards so that their drives appear faster than they actually are. For example, some of the 
first triple-speed CD-ROM drives were really single-speed or double-speed drives with 
large caches. If you lower the data rate of the troublesome movies to levels acceptable for 
single-speed or double-speed playback, your problem may be resolved. 

Movie looks blocky or streaky in some sections

The movie’s data rate is not high enough for the images that you are compressing. You can 
either increase the data rate of your movie, or—if you want to maintain the current data 
rate—lower the frame rate or frame size.
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Audio playback problems on Windows computers

Most likely, the sampling rate for your audio is wrong. Windows sound cards have prob-
lems playing back anything but sound processed using discrete sampling rates, such as 
44100 Hz, 22050 Hz, or 11025 Hz. You should also make sure your movie does not use 
more than one sampling rate. 

Every third frame of the movie is duplicated

You are witnessing a phenomenon known as 3-2 pulldown, or teleciné, that occurs when 
film is converted to video. Because film runs at a lower frame rate than video (24 fps 
for film, 30 fps for video) every third frame of the source film is duplicated during the 
conversion process to account for the time difference. You can minimize the effect of 3-2 
pulldown by compiling your movie at a different frame rate or by starting the movie on 
a different frame; however, you cannot eliminate 3-2 pulldown entirely.

Making movies .avi compatible

The CD-ROM Movie Maker cannot make an .avi movie; however, there are several pro-
grams that you can use to make them. Adobe Premiere for Windows can be used to convert 
QuickTime movies into Video for Windows compatible or .avi movies. A Windows pro-
gram called TRMOOV will convert a .mov file to an .avi file without recompressing 
frames. TRMOOV is available on the Internet at http://www.sfcanyon.com/util.htm. This 
program is not supported by Adobe Systems, Inc.

Movie frame rate slows when played back from Macromedia Director

In Director, a QuickTime movie takes on the characteristics of a sprite; that is, it can be 
blended, overlapped, or put behind other sprites. If you want the movie to behave like a 
normal QuickTime movie, you need to use the Lingo command direct to stage of cast. This 
command makes the movie play in front of all other sprites. Also be sure to set the frame 
rate of your Director movie to 30 fps or more. If you are using a lower frame rate, there 
may not be enough time for the movie to update itself. For more information, consult 
your Macromedia Director user guide. 

The Data Rate Analyzer indicates more key frames than expected

Cinepak will create a key frame automatically when it encounters a frame with a large 
amount of new information, making it difficult to create a differenced frame based on the 
previous key frame. It’s entirely dependent on the source material. This can occur even if 
you specify a key frame rate. The CD-ROM Movie Maker cannot prevent Cinepak from 
creating a key frame, it can only force the creation of one.
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Improving Performance

 

program’s 

 

performance

 

 is the amount of time it takes the application to complete 
certain operations, such as opening a file, processing effects, or redrawing the 
screen after you edit an image. In part, performance is determined by the type of 

computer and amount of memory you’re using. Other factors that can dramatically 
impact Adobe Premiere performance include your software setup, how much RAM you 
have, your use of virtual memory, and the size and complexity of your files. 

 

OPTIMIZING MEMORY SETTINGS

 

The best way to improve performance with large files is to increase the RAM installed on 
your computer and allocated to Adobe Premiere. Testing at Adobe Systems has shown that 
increasing the amount of RAM installed on a system tremendously improves the overall 
performance of Adobe Premiere.

You can optimize Adobe Premiere performance by making these three memory settings:

 

•

 

Increase the amount of RAM installed on your system and allocated to Adobe Premiere. 
The minimum amount of application RAM required to run the Adobe Premiere program 
is 4 MB on a 68020 series Macintosh, 6 MB on a Power Macintosh, and 6 MB if you are 
using the universal version of Adobe Premiere. If you have 8 MB of RAM or more, set the 
application memory size as high as possible, allowing 1 to 2 MB of RAM for the system. 

 

•

 

If you have more than 8 MB of RAM, you should turn on 32-bit addressing before 
increasing the application memory size.

 

•

 

Turn off the System 7 virtual memory—temporary hard disk space used for storing data 
when RAM is insufficient. Using System 7 virtual memory with the QuickTime extension 
is not recommended; doing so will significantly degrade the performance of the Adobe 
Premiere program.

 

To optimize the memory settings:

 

1

 

Start all applications, 

 

except

 

 Adobe Premiere, that you will be using at the same time as 
Adobe Premiere.

 

2

 

Return to the Finder. Choose About This Macintosh from the Apple menu. 

 

3

 

Refer to the Largest Unused Block value. This value shows the amount of memory cur-
rently available. 

 

4

 

Subtract 1 MB to 2 MB of that value for system use, and note the result. You will use this 
result in step 10.

 

A
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5

 

Choose Control Panels from the Apple menu and double-click the Memory icon. Set the 
disk cache size between 32K and 96K.

 

6

 

Click Virtual Memory Off.

 

7

 

If you are using System 7 on a non-Power Macintosh with more than 8 MB of RAM, 
click On for 32-bit addressing. 

The 32-bit addressing capability enables applications to access more than 8 MB of RAM.

 

Note: 

 

Macintosh computers prior to the IIfx and IIci models do not support 32-bit addressing, 
but they can use MODE 32 by Connectix Corporation to take advantage of 32-bit addressing. 
To obtain a copy of MODE 32, call Apple customer assistance at 800-776-2333.

 

8

 

Restart your Macintosh for the change to take effect.

 

9

 

Select the Adobe Premiere icon, and choose Get Info from the File menu. 

 

10

 

In the Adobe Premiere Info window, set the Current Size option (or the Preferred Size 
option if you’re working in System 7.1 or later) to the amount of memory you noted in 
step 4.

 

11

 

Close the Adobe Premiere Info window. 

 

DISABLING APPLETALK

 

When running Adobe Premiere with full-motion movies, you should turn off AppleTalk

 



 

. 
AppleTalk requires a considerable number of CPU cycles, so it could cause frames to drop 
during the recording and playback of movies. 

To disable AppleTalk, choose File > Tools > AppleTalk Control in Adobe Premiere.

 

MANAGING FONTS

 

Organizing your fonts efficiently can help improve overall system performance. You can 
use a font management utility (such as Suitcase

 



 

 or MasterJuggler

 



 

, available from your 
computer dealer) to help manage your fonts and create font suitcases. If you are using 
ATM and plan to use large display sizes, be sure to increase the size of the ATM font cache 
to at least 512K and keep only one size of each typeface in your suitcases. For more infor-
mation on using ATM, see “Selecting ATM Options” on page 30.
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Using the ATM Program

 

he Adobe Premiere package includes Adobe Type Manager (ATM) software, 
which gives all your applications a smooth, high-quality display for Adobe 
Type 1 fonts.

ATM is a font utility that generates sharp, clear characters of any size on-screen and on 
QuickDraw

 



 

 printers. With ATM, you install the outline fonts and one bitmap font for 
each font you want to use; ATM then creates bitmap characters of any size for the font 
from the Type 1 outline fonts. ATM is installed when you choose the Easy Install installa-
tion option; you can also install ATM by choosing the Customize installation option and 
selecting the ATM software.

 

SELECTING ATM OPTIONS

 

The ATM control panel includes options for turning ATM on and off, changing the font 
cache size, and determining how character shapes and line spacing appear when you use 
various applications. If you change an ATM option, you must restart your Macintosh for 
the changes to take effect.

 

To select ATM options:

 

1

 

Choose Control Panels from the Apple menu. The Control Panels window appears.

 

2

 

Open the ATM control panel by double-clicking the ATM icon in the Control Panels 
window.

 

Note:

 

 The Substitute for Missing Fonts option is dimmed unless you have installed the ATM 
font database that comes with Super ATM

 



 

. 

 

3

 

Select ATM options as follows:

 

•

 

On/Off

 

 turns the ATM software on and off.

 

•

 

The 

 

Font Cache

 

 sets the amount of system memory available to store bitmap characters 
created by the ATM program. The default setting is 256K. Adobe recommends a font cache 
of at least 512K for Adobe Premiere and at least 64K for each Type 1 font that you use. 

 

•

 

Preserve Line Spacing

 

 (the default) reduces the size of accented characters to fit within 
the current line height and retains the same line and page breaks within a document. This 
option may clip the descenders of some characters. 

 

T
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•

 

Preserve Character Shapes

 

 maintains the size of accented characters and increases the size 
of the current line height to accommodate the larger characters.

 

•

 

Substitute for Missing Fonts

 

 instructs ATM to create replacement fonts from available 
Type 1 fonts if the original font is missing.

 

4

 

Choose Restart from the Special menu. You must restart your Macintosh for changes to 
the ATM control panel to take effect.

 

REMOVING ATM FROM YOUR SYSTEM

 

At times, you may want to turn off ATM temporarily, or you may want to remove ATM 
from your system.

 

To turn off ATM temporarily:

 

Hold down the Shift key while starting your Macintosh. The ATM icon appears on-screen 
with an 

 

X

 

 through it, indicating that ATM is not being loaded.

 

To remove ATM from your system:

 

1

 

Drag the ATM control panel from the Control Panel folder onto the desktop. If you are 
removing ATM version 3.6 or earlier, you must also drag the ATM 68020/030/040 icon 
from the System Folder onto the desktop. 

 

2

 

Restart your Macintosh; then drag the icons to the Trash.


